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AthenaVisual Plus v21.1 to v22.0

Fixed: Miscellaneous bugs and cosmetic changes reported by the user community.

2. Modified: The implementation of the Runge-Kutta-Fehlberg integrator (RKPLUS) to

be consisted with the DDAPLUS default integrator. The user now can switch from
one integrator to the other, as long the system of differential equation has and E ()
Matrix equal to identity (i.e. System of Pure Differential Equations)

Implemented: The DIPPR 127H equation for the calculation of the ideal gas heat
capacity.

Modified: All Physical property procedures to comply with the implementation of
the new equation (DIPPR 127H) for the ideal gas heat capacity.

Modified: The integrator (DDAPLUS and RKPLUS) return logistics from a hard
stop to a return to the calling program with additional information of the integration
process up to the point of failure

Fixed: The calculation of the objective function during the line search when the user
uses the prior information to update the model adjustable parameters for Bayesian
Estimation.
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11.
12.
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14.
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16.

17.

18.
19.

AthenaVisual Plus v21.1 to v21.2

Fixed: Miscellaneous bugs and cosmetic changes reported by the user community.
Fixed: Block Integration of experimental data with differential models that exhibit
explicit discontinuities.

Fixed: Compilation bug when predictive mode in parameter estimation is enabled
with Sensitivity Analysis option active.

Implemented: Parameter estimation graphics control pane with the responses
displayed in a drop down list for easy selection. This feature is activated by setting
Param(152)=1. The default value is Param(152)=0.

Implemented: Access to the Intel Fortran Compiler oneAPI 2024

Implemented: Code parallelization for parameter estimation with user explicit
models when using the Least-Squares AthenaVisual Plus solver. This option is
activated first by selecting Allow for Code Parallelization under Tools:
Preferences: Project Options and then selecting Enable Code Parallelization in the
Parameter Estimation Solver Control Panel: Advanced Options.

Implemented: Option to access the CPU Resource Monitor. This option is available
under the Tools menu in AthenaVisual Plus.

Implemented: Option to enter the Intel Visual Fortran version via Param(169) and
the Microsoft Visual Studio version via Param(147). For instance the user may enter
Param(169)=2024.2 and Param(147)=vs2022 or using the corresponding keywords
IntelFortranVersion=2024.2 and VisualStudioVersion=vs2022

Fixed: Model discrimination method based on the Akaike Information Criterion
based on weights.

Implemented: Option to change the method for model discrimination and ranking
based on the Akaike Information Criterion(AIC). The default method for
discrimination and ranking is done based on Weights. There are two more methods
one based on Akaike Differences and the other on the Likelihood of the candidate
models.

Implemented: Option to enter the installation folder of Microsoft Visual Studio via
Param(124). For instance the user may enter Param(124)="C:\Program
Files\Microsoft Visual Studio\2022\Community”. The installation folder must be
contained in quotes. When using this option the user must also enter the correct
version of Microsoft Visual Studio using the keyword VisualStudioVersion as
described above in item 8. The corresponding keyword for Param(124) is
VisualStudioFolder

Fixed: Launching of the Microsoft Visual Studio for 64-Bit projects.

Imroved: The PT Flash calculation has been improved for more robust convergence.
Also upon failure it no longer throws a Stop command, rather it returns to the calling
program with the value of v(ncc+8,10)=-1 where v(ncc+8,10) is the final result of the
flash calculation prior to failure.
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AthenaVisual Plus v20.0 to v21.1

Fixed: Miscellaneous bugs and cosmetic changes reported by the user community.

. Fixed: The Insert Function menu item from the Model menu. Some external

functions were misaligned in the list boxes. For each function now, the user can see
the appropriate compiler in 32-Bit or 64-Bit mode

Fixed: Because of inappropriate default values of the Param(121) option, then
number of bin for histogram plots was sometimes set to 1 and that cause
AthenaVisual Plus to fail. This was fixed by setting the default value of Param(121)
equal to 8: Param(121)=8

Fixed: Error capture when using Microsoft Visual(MS) Studio for the very first time
and the association of .sIn files to MS Studio was missing.

Modified: The IFORTvariables.bat file to accommodate oneAPI 2023

Changed: Prt keyword in Solver Options to PrintLevel.

Implemented: User can now specify the ASPEN Plus version using Param(150) and
instruct AthenaVisual Plus to run a standalone model that calls ASPEN Plus Flash
routines with Param(151). The corresponding keywords are AspenPlusVersion and
AspenPlusRun.

Fixed: A bug in the License manager that incorrectly processed user names.



Athena Visual Studio v14.2 to AthenaVisual Plus v20.0

1. Fixed: Miscellaneous bugs and cosmetic changes reported by the user community.

2. Overhauled: The entire software package was overhauled to adhere to the new
Windows Operating systems (10 and now 11) with numerous changes in the
Graphical User Interface (GUI), the Fortran Compilers, the solvers for estimation and
integration of ODEs and PDEs, and the Physical Properties methods that now include
new equations of state, flash calculations as well as bubble point and dew point
calculations. It is next to impossible to describe all the changes that went into effect
with this overhaul of the software. Finally the software was modified in order to
generate both 32-Bit and 64-Bit Dynamic Link Libraries for seamless interface with
Microsoft Excel and Commercial simulators (ASPEN Plus, ASPEN Hysys and
UniSim)
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Athena Visual Studio v14.1 to v14.2

Fixed Bugs: Miscellaneous bugs reported by the user community.

. New Feature: Parameter Param (205) in the @Solver Options section if set to a

value greater than zero forces Athena to stop at a discontinuity point other than the
very first one. For instance setting Param (205)=1 will force Athena to stop at the
second discontinuity point if it exists.

License Information: Updated Athena Visual Studio License information. To view
the update from the Tools menu select Athena Visual Studio License Manager and
then click View Athena Visual Studio License Terms.
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Athena Visual Studio v14.0 to v14.1

Fixed Bugs: Miscellaneous bugs reported by the user community.

. User Functions: Added an option to use Fortran 90 syntax for user functions. In this

way the user has the freedom to specify vector as well as complex functions. See
Athena Visual Studio example in the ...\Samples folder (mcComplex.avw).
Keyword: Added new keywords for solver control via the @Solver Options section
in the modeling code. To view all keywords, open an Athena Visual Studio project
and from the View menu select Solver Parameters.

New Functions: Added new functions rand and randNormal to generate random
numbers from uniform and normal distributions. See Athena Visual Studio help file
for details of the implementation of these functions and examples in the ...\Samples
folder (mcRand.avw and mcMonteCarlo.avw).

New Functions: Added new mathematical functions FirstOrderDerivative and
SecondOrderDerivative and FluxDerivative to calculate derivatives using Finite
Difference formulas on uniform grids. See Athena Visual Studio help file for details
of the implementation of these functions and examples in the ...\Samples folder
(mcFiniteDifferences.avw).

New Functions: Added new physical property functions EnthalpyForm and
GibbsForm and StdLigDensity to calculate the standard enthalpy of formation, the
standard Gibbs free energy of formation and the standard liquid density of user
selected components. See Athena Visual Studio help file for details of the
implementation of these functions and examples in the ...\Samples folder
(mcPhysicalProperties.avw and mcPPHelp.avw).

New Feature: Parameter Param(204) in the @Solver Options section if set to one
forces Athena to use the Run Sequence Plot as the default. If it is set equal to zero
forces Athena to use the Parity plot as the default.

New Feature: A submenu in the Parameter Estimation Solver control panel
allows the user to select all responses for estimation and also to clear the selected
responses. The submenu is activated by a right mouse click on the list box that
displays all the responses.
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Athena Visual Studio v12.3 to v14.0

Block Data Structure: Beginning with v14.0 users will be able to define block data
structures for parameter estimation form multiresponse data. See example
PEM2S.avw in the C:\Program Files\Athena\Samples\Parameter Estimation Models
folder.

New Functions: Added new functions Simpson and Gauss for the calculation of the
definite integral of smooth functions. See Athena Visual Studio help file for details of
the implementation of these functions and examples in the ...\Samples folder
(mcFunlntegral.avw and mcSimpson.avw)

Fixed Bugs: Miscellaneous bugs that were persistent in the VisualKinetics Module.
Updated Chemical Engineering Topics Help: Miscellaneous improvements to the
Chemical Engineering subjects that are described in this help file.

Plot Functions under Tools menu: This option has been extended to include user
models that can be supplied via Dynamic Link Libraries that can be generated by
Athena Visual Studio. The names of these DLLs must be Sub Fx(x,y,iFx) for two-
dimensional plots and Sub Fxz(x,z,y,iFxz) for three-dimensional plots. The integer
arguments iFx and iFxz allow the user to enter more than one function in the same
subroutine. Furthermore the following functions have also been implemented:

min, max, range, sum, gamma, gami, gamic, psi, erf, erfi, erfc, erfci, beta, betai,
ndist, ncdist, ninv, tdist, tcdist, tinv, fdist, fcdist, finv, chidist, chicdist, chiinv,
wdist, wedist, winv, Indist, Incdist, Ininv, betadist, betacdist, betainv, gammadist,
gammacdist, gammainv, besj, besy, besi, besk.

All these functions are described in detail in the Athena Visual Studio Help file. The
syntax for calling the user DLLs is y=Fxz(x,z,1)[;y1=Fxz(x,z,2)]. These DLLs must
be placed in a folder that is in a searchable by Windows path such as C:\Windows.
Type Variables: Type variables can now be coded in Athena Visual Studio as
follows:

$$Type Input

$$ Real*8:: Temperature

$$ Real*8:: Pressure

$$ Real*8:: Composition(100)
$$ Real*8:: Kvalues(100)
$$End Type Input

Dim myInput As Type(Input)
Input%Temperature=200.0

A better way to implement Type variables is via a module. That gives the user more
flexibility. An example of that can be found in the Athena Visual Studio samples
folder \Athena\Samples\Fortran90\TestModule.avw
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16.

New Subroutine: A new subroutine has been added in the AthenaUtilities module.
The subroutine HessianMatrix( FCN, X, Hess [,Gradient] [,Eps] ) can be used to
calculate the Hessian matrix and the Gradient vector of a scalar function that is
supplied by the External FCN. An example of that can be found in the Athena Visual
Studio samples folder \Athena\Samples\Stand Alone Models\mcHess.avw. This
example is fully functional with the Compaq and Intel Visual Fortran Compilers. If
you are using the g95 compiler you must delete the references to the Athena module
and the call to mcHess subroutine and the Hessian function.

Fixed Bug: The Help command button was disabled in the Fortran and Code
Generation Options menu item under Build for the Compaq and Intel Compilers.
This bug was been fixed in v14.0

Update Help File: Updated the Fortran Programming Review section of the
Fortran Compilers Help file.

New Statement: Implemented the NameList Fortran specification statement. The
NamelList statement specifies a list of variables which can be referred to by one name
selected by the user, for the purpose of performing input and/or output. An example
of this specification statement can be found in the Athena Visual Studio samples
folder \Athena\Samples\Ordinary Differential Equations\ODE20.avw.

Fixed Bug: Sensitivity analysis with respect to initial values for differential and
partial differential equations would not work if the number of equations was a
variable and not a number. This bug has been fixed in v14.0.

Fixed Bug: A bug was fixed in the Replace text window in the Athena Editor. The
bug would show only if there were blank lines at the end of the user code and the
Replace All command was issued followed by the Find Next command.

New Feature: Added function doublelntegral to calculate definite double integrals>.
An example of this function can be found in the Athena Visual Studio samples folder
\Athena\Samples\Stand Alone Model\mcDoubleIntegral.avw

Update Help File: Updated the General Mathematics Module section of the Athena
Visual Studio Help file.

New Feature: Beginning with version v14.0 the user will be able to pass the Number
of Equations, Number of Integration Points and Number of Continuation points as
arguments into model subroutines for algebraic and differential models. This can be
accomplished by issuing the following statement in the Solver Options section of the
Athena code: variableNEQ=myNeq;myNpts;myNptcon. Here myNeq is the
number of equations, myNpts the number of integration points and myNptcon the
number of continuation points.

New Feature: Beginning with version v14.0 the user will be able to pass the Number
of Equations, Number of Grid Points, Number of Break Points, Number of
Integration Points and Number of Continuation points as arguments into model
subroutines for partial differential and boundary value models. This can be
accomplished by issuing the following statement in the Solver Options section of the
Athena code: variableNEQ=myNeq;myNgrid;myNbreak;myNpts;myNptcon.
Here myNeq is the number of equations, myNgrid the number of grid points per
element, myNbreak the number of breakpoints, myNpts the number of integration
points and myNptcon the number of continuation points
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New Feature: Beginning with version v14.0 Athena will offer a number of functions
to perform Flash calculations for Vapor/Liquid mixtures as well as Flash calculations
of mixed streams with conventional components and solids. Please check the Physical
Properties documentation for detailed information.

New Feature: Beginning with v14.0 Athena will offer two functions pSteam and
wSteam that will calculate steam and wet steam properties. To view a description of
these functions check the Physical Properties book under Athena Visual Studio Help.
New Feature: Beginning with version v14.0 Athena will offer a splines calculation
block for easy interpolations. The block contains three functions: AkimaSplines,
Cubic Splines and Quadratic Splines. Please read the General Mathematics Module
help on Spline Interpolation.

New Feature: Beginning with version v14.0 the Runge-Kutta methods for the
integration of mildly stiff ODE’s have been enhanced to handle explicit
discontinuities in the time domain.

New Feature: Beginning with version v14.0 users will be able to identify solid
components in the Physical Properties window. Set the Solid State to 0 for a
conventional component or 1 for a solid component.

New Feature: Beginning with v14.0 a new interface to the Athena functions and
utilities has been implemented. The interface categorizes the functions into Fortran,
Mathematical and Numerical, Statistical, Text and Utilities, Thermo and Unit
Conversions so that it is very transparent to the user. The help files have also been
updated to reflect the new architecture for the Athena Functions.

New Feature: Object files linked to the user project no longer need to be placed in
folders with empty spaces in the path name. An API that converts long path names to
short path names has been implemented, so that the path names are compatible and
the command option of the Compaq and Intel Visual Fortran Compilers.

New Feature: Beginning with v14.0 users will be able to link the Athena Libraries
with stand alone Fortran code.

New Feature: Beginning with v14.0 users will be able to use the includeLocal
keyword to includes parts of Fortran compatible code anywhere in their Athena
project. Furthermore the $include keyword allows for the user to insert declaration
statements that are coded in a separate file. The files accessed by the include and
inludeLocal keywords must have filetype .for or .f

New Feature: Beginning with v14.0 the user will be able to enter all the elements of
the Param( 1 to 200 ) vectors that controls the Athena solvers through the @Solver
Options section. To view a brief description of all Param(1 to 200) elements, open
Athena Visual Studio , and from the View menu select Solver Parameters.



27. New Feature: Beginning with version v14.0 users will be able to specify blocks of
code as comments. The block of code is marked as follows:

!'*BEGIN: Start block of code that will be commented out by the Athena parser

Statement 1
Statement 2

'*END: End block of code that will be commented out by the Athena parser

! *BEGIN and ! *END are required keywords. Anything else is optional. To request

the Athena parser to process this block of code simple remove the * character from
the ! *BEGIN keyword.



Athena Visual Studio v12.2 to v12.3

Updated Parameter Estimation Tutorial: Added description on the use of
sensitivity analysis for the calculation of the gradient vector

Updated Athena Visual Studio Help: Updated the section on Parameter Estimation
with Implicit Models to synchronize with the Parameter Estimation Tutorial.
Updated General Mathematics Module: Update the documentation of the General
Mathematics Module and introduced a complete set of functions for the LQ
Decomposition of a rectangular matrix A(m,n) . The old getQ function was replaced
by the getQ1I because it was calculating the Q1 and NOT the Q matrix of the LQ
decomposition. The complete set of functions for the LQ Decomposition of a
rectangular matrix with full row rank, is given in the Athena On Line Help manual.
To access it, open Athena Visual Studio and from the Help menu select Athena
Visual Studio Help and then click General Mathematics Module. From there, you
may select the topics Matrix Operations and Matrix Operations...Continued
Fixed Bug: In the previous versions of Athena Visual Studio the semi-normalized
sensitivity coefficients were computed incorrectly at the break points in the time-like
dimension for mixed systems of differential and algebraic equations. The calculation
was also incorrect for systems where the initial values of the first order sensitivity
functions were non-zero. This bug has been fixed in version 12.3

Updated Stand Alone Models Folder: Updated and cleaned up the folder that
contains User Defined Models (Stand Alone Models). All examples now have a
suitable self-descriptive name.

Minor Improvements: In the Graph control panel textboxes the Fonts were changed
to Arial and the 3D graphics in the solution of PDEs were improved.

License Manager: License manager was updated to accommodate users with very
restricted privileges in University Networks. This feature applies only to Academic
License holders.

Update Athena Visual Studio Help File: Updated the Miscellaneous Topics book in
the Athena Visual Studio Help file to reflect the addition of new keywords for
drawing true 3-dimensions graphs. The new keywords are Elevation, Rotation and
Perspective.

New Feature: Introduced a new feature; under the Tools menu the user can select
Plot Functions in order to plot 2-dimensional (y=f(x)) and 3-dimensional functions

(y=f(x,2)).
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Athena Visual Studio v12.1 to v12.2

Add Function: Added the char Fortran Intrinsic in the reserved words list.

. Fix Bug: Fixed a bug occurring when the user selected a compiler in the Options

window. The g95 compiler tab was not disabled or enabled based on the user’s
selection.

Fix Bug: Fixed a bug occurring when setting up Parameter Estimation or Nonlinear
Optimization problems from Process Models that are active in Athena. The setup is
now canceled when user changes his/her mind or chooses the same file name for
estimation/optimization as the one for the Process Model.

Fix Bug: Fixed a bug occurring when user double-clicks in an Error window
(myAPP.ERR) to locate an offending statement when a floating point exception or
FORTRAN compilation error occurs. There is no check to ensure that the offending
line number does not exceed the number of lines in the file that contains the offending
statement. This error was not trapped and it caused Athena Visual Studio v12.1 to
close.

Add New Example: Added the Rat43 test case form the NIST Statistical Reference
Datasets http://www.itl.nist.gov/div898/strd/ in the installation folder C:\Program
Files\Athena\Samples\NIST Statistics.

Fix Bug: Fixed a bug occurring when the user selects the compilation option —fpe:0
(under the Compaq and Intel Visual Fortran Compilers). Athena’s engine throws an
exception due to overflow. This exception comes from the LAPACK function
DLAMCH that computes machine parameters. This bug has been fixed via a keyword
through the Solver Options. To avoid the floating point exception thrown by
Athena’s engines when the —fpe:0 option is wused, the wusers sets
MachineParameters=1 in the Solvers Options section of the Athena code.

Athena Interface: Minor updates to the Welcome: New Mode Selection Panel
Window

Athena Interface: Updated the Athena Toolbar by adding a button to online Help.
Fixed small errors in the shortcuts of various menu items. Some items were given the
same shortcut letter.

Fix Bug: Fixed a bug in the Partial Differential Equations training sample. The
equation form based on the dimensionless state variables was incorrect.

Fix Bug: Fixed a bug in the Visual Kinetics Control Panel. Second option for the
selection of the reaction rate constants did not update the headers of the
corresponding spreadsheet

Fix Bug: Fixed a bug in the Optimal Experimental Design control panel. The data file
with the proposed experimental design was very large because of the way it was
saved. The file now is only a few KB large.

Athena Tutorials: Added a Nonlinear Optimization Tutorial

Athena Tutorials: Added a Boundary Value Problems Tutorial

Athena Tutorials: Added a Partial Differential Equations Tutorial

Athena Tutorials: Added a Visual Kinetics Tutorial
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23.

Athena Sample Files: Updated description of Athena Samples in the Algebraic
Models folder, Partial Differential Equations folder and Nonlinear Optimization
folder

Athena Interface: Enhanced Athena Toolbar with two shortcuts for debugging with
Intel and Compaq compilers, and optimal experimental design

Athena Training Samples: Added a Nonlinear Constrained Optimization sample.
Update Help Files: Update the Athena Knowledge Base help file.

Update Help Files: Update the Chemical Engineering Topics help file

Update Help Files: Update the Athena Visual Studio Help file

Update Help Files: Update the Fortran Compilers Help file

Update Help Files: Update the Athena Solvers Help file



Athena Visual Studio v11.0 to v12.1

General Improvements

Introducing the Athena Visual Studio Knowledge Base
Ability for Version Control (Compaq and Intel Compilers only)
Enhanced Chemical Engineering Help Material
Enhanced Statistical Methods Help Material
Enhanced Tutorials for Beginners
On-Line Compiler Options
Numerous Mathematical and Statistical Functions
Detailed Documentation of Mathematical and Statistical Functions
Added Graph Configuration File
. Added Component Insert Mode in Physical Properties
. Ability to create DLLs with Variable Number of Equations
. Ability to create Closed and Open Form Models with Variable Number of
Equations
13. Ability for User to Enter FORTRAN 95 Variable Declarations
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14. Seamless integration with the Compaq Visual Debugger with a Single Click
15. Seamless Integration with the Intel Visual Debugger with a Single Click

16. New License and Security Manager

17. 15 Day FREE Evaluation Period (extended to 30 Day upon request)

18. FREE Classroom Instruction License with Purchase of the Academic Research
License

19. Athena Visual Studio v12.1 runs under Windows VISTA

20. User Account Control (UAC) Manager for Windows VISTA

21. Improved, Searchable and well Organized Documentation

22. Getting Started Help for Beginners

23. New Expanded and Improved Monitor Statement

24. Implementation of Shape-Preserving Quadratic Spline Interpolation

25. Improved Interfaces and Bug Fixes from User Feedback

26. Smart User Code for Solver Manipulation and Solver Options Command Section

27. Enhanced Printing (Jacobian Matrices) and Troubleshooting



Parameter Estimation and Model Discrimination

Nk W=

Introducing Improved and Enhanced Optimal Experimental Design
Continuous Monitoring of the Estimation Progress (for Large Problems)
Simultaneous Integration of Blocks of Experimental Data for Fast Estimation
Version 12.1 Allows for Missing Settings and Responses

Version 12.1 Allows for Character Settings (ex. Catalyst Name or Type)
Version 12.1 Allows the User to Select Responses for Fitting

Grubbs' Test for Detecting Outliers

Ordinary Differential and Algebraic Systems

1.
2.
3.
4.

State and Sensitivity Vector Relative and Absolute Tolerances
Implementation of Runge-Kutta 4th and 5th Order Integration Algorithms
Implementation of Explicit Auxiliary Variables

Introducing Ability to Store Integration History (Successful Steps)

Partial Differential Systems

A

Setup the Framework for Two-Dimensional Partial Differential Equations

New Discretization Schemes for Hyperbolic PDEs

Inhomogeneous domains with state and flux discontinuities

State and Sensitivity Vector Relative and Absolute Tolerances

Finite Differences on Finite Elements with User Imposed Continuity Conditions
Implementation of Explicit Auxiliary Variables



